
 

 

 

 

 

 

Программное обеспечение 

Precision Melt Analysis™ 

 

Руководство пользователя 

 

 

Кат. # 184-5025 

 

 





 

i 

Все права защищены. ©2009 Bio-Rad Laboratories, Inc. Копирование и воспроизведение 

этого документа в любой иной форме, печатной или электронной, без письменного 

разрешений Bio-Rad Laboratories, Inc. запрещено. 

Excel, Microsoft, Windows, Windows XP, и Windows Vista являются торговыми марками 

Microsoft Corporation. Adobe и Reader являются торговыми марками Adobe Systems 

Incorporated. SYBR является торговой маркой Invitrogen Corporation. Компания Bio-Rad 

Laboratories, Inc. лицензирована Invitrogen Corporation на продажу реагентов, содержащих 

SYBR Green I, для использования в ПЦР в реальном времени только в исследовательских 

целях. EvaGreen является торговой маркой Biotium, Inc. Компания Bio-Rad Laboratories, 

Inc. лицензирована Biotium Inc. на продажу реагентов, содержащих Eva Green, для 

использования в ПЦР в реальном времени только для исследовательских целей. HRM 

является торговой маркой Corbett Life Sciences и ее дочерних компаний. LCGreen является 

торговой маркой Idaho Technologies, Inc. SYTO9 является торговой маркой Invitrogen 

Corporation. Другие бренды или названия продуктов являются торговыми марками их 

соответствующих владельцев. 

 

 

 

 

 

 

 

 

 

Информация об авторских правах 

Амплификаторы компании Bio-Rad Real-time thermal cycler CFX96 или CFX384 

лицензированы для проведения ПЦР в реальном времени в рамках патента США No. 

6,814,934 B1 компании Applera для использования в исследовательских и любых других 

областях за исключением ветеринарной диагностики. 

Амплификаторы компании Bio-Rad Real-time thermal cycler CFX96 или CFX384 защищены 

одним или более патентами США, их аналогами или патентными заявками в других 

странах, принадлежащими Eppendorf AG: патенты США Nos. 6,767, 512 и 7,074,367. 

Никакие права не передаются, намеренно, косвенно или процессуально, на патенты, 

покрывающие методы ПЦР или реагенты и наборы реагентов.  

Плашки Hard-Shell производства компании Bio-Rad защищены одним или более 

патентами США, их аналогами или патентными заявками в других странах, 

принадлежащими Eppendorf AG: патенты США Nos. 7,347,977, 6,340,589, 6,528,302 и 

патентные заявки США 2007246858, 20080084004, 20030180192 и 20060120927. 

Компания Bio-Rad Laboratories, Inc. лицензирована Biotium Inc. на продажу реагентов, 

содержащих краситель EvaGreen, для использования в ПЦР в реальном времени только в 

исследовательских целях. 

SYBR Green является торговой маркой Molecular Probes, Inc. EvaGreen является торговой 

маркой Biotium, Inc. 



 

ii 

Поддержка компании Bio-Rad 

Компания Bio-Rad предоставляет разнообразные ресурсы для исследователей, включая 

обширные технические ресурсы и широкий спектр методов и приложений в области ПЦР, 

ПЦР в реальном времени, экспрессии генов и HRM-анализа. В Таблице 1 суммированы 

ресурсы и поддержка, предоставляемые компанией Bio-Rad. 

Таблица 1. Ресурсы Bio-Rad. 

Ресурсы и поддержка Как найти 

Региональные 

представители Bio-Rad 

Laboratories 

Информацию о Вашем региональном представителе и его 

контактную информацию можно найти на интернет-сайте 

компании Bio-Rad, выбрав Вашу страну из списка на 

домашней странице (www.bio-rad.com). Список 

международных офисов приведен на последней станице этой 

инструкции. 

Технические замечания 

(Technical Notes) и 

литература 

Посетите сайт компании Bio-Rad (www.bio-rad.com) или Gene 

Expression Gateway (www.bio-rad.com/genomics). Введите 

поисковый запрос в строке Search и выберите Literature для 

поиска ссылок на технические замечания, руководства 

пользователя и другую литературу. 

Технические 

специалисты 

Отдел технической поддержки (Technical Support) компании 

Bio-Rad укомлектован опытными исследователями для 

возможности предоставления пользователям 

высококвалифицированных практических советов. 

Для технической поддержки по телефону контактируйте с 

ближайшим к Вам офисом компании Bio-Rad. Для 

технической поддержки в США и Канаде звоните 1-800-424-

6723 (звонок бесплатный) и выберите опцию технической 

поддержки. 

 

 

Обозначения, используемые в этом Руководстве пользователя 

Обозначения, используемые в этом Руководстве, суммированы в Таблице 2. 

Таблица 2. Обзначения, используемые в Руководстве пользователя. 

Обозначение Значение обозначения 

ПОДСКАЗКА: Используется для обозначения полезной информации и 

инструкций, подробно описанных в других частях 

руководства  

ЗАМЕЧАНИЕ: Используется для обозначения важной информации, в том 

числе информации, детально разобранной в других частях 

руководства 

ВНИМАНИЕ! Используется для обозначения очень важной информации, 

касающейся возможной потери данных 

X > Y Выберите в панели инструментов, меню или окне программы 

сначала X, затем – Y.  

      

http://www.bio-rad.com/
http://www.bio-rad.com/
http://www.bio-rad.com/genomics
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Глава 1. HRM-анализ 

 

В этой главе содержится информация об анализе плавления высокого разрешения (high 

resolution melt analysis, HRM-анализ). 

 Введение в HRM-анализ (см. ниже) 

 Советы для успешного HRM-анализа (стр. 2) 

 Совместимость красителей (стр. 3) 

 HRM-анализ в литературе (стр. 4) 

 

Введение в HRM-анализ 

ПЦР в реальном времени с использованием неспецифических ДНК-связывающих 

красителей, таких как SYBR Green, обычно включает анализ кривой плавления после 

проведения ПЦР для подтверждения амплификации единственного продукта или для 

детекции возможного присутствия праймер-димеров или других нежелательных 

продуктов амплификации. 

Для анализа кривой плавления температура постепенно увеличивается и проводится 

мониторинг флуоресценции как функция температуры. При возрастании температуры 

происходит высвобождение флуорофора из денатурированной двухцепочечной ДНК и 

флуоресценция спадает с существенным изменением в скорости падения при достижении 

температуры плавления (Tm) двухцепочечной ДНК, то есть теоретической температуры, 

при которой половина ДНК находится в двухцепочечном, а половина – в одноцепочечном 

состоянии. Скорость изменения определяется при построении графика первой 

производной относительной флуоресценции (relative fluorescence, RFU) по температуре  

-d(RFU)/d(T) от температуры, позволяя выявить пик, который является Tm комплексов 

двухцепочечной ДНК. Праймер-димеры обычно плавятся при более низкой температуре 

благодаря их меньшему размеру, делая возможным дискриминацию амплифицированного 

продукта ПЦР от праймер-димеров и других неспецифических продуктов. 

HRM-анализ может рассматриваться как следующее поколение техники анализа кривых 

плавления. HRM-анализ позволяет генерировать профили кривых плавления, которые 

достаточно специфичны и чувствительны для разделения нуклеиновых кислот на 

основании незначительных различий в них, что делает возможным сканирование мутаций, 

анализ метилирования и генотипирование. 

HRM-анализ может использоваться для характеризации образцов на основании их CG-

состава и комплементарности последовательностей ДНК. Например, HRM-анализ может 

быть использован для детекции однонуклеотидных вариаций, таких как 

однонуклеотидный полиморфизм (single-nucleotide polymorphism, SNP) или для 

выявления неизвестных генетических мутаций. Он также может применяться для 

количественной детекции незначительной части вариантов ДНК на фоне ДНК «дикого» 

типа с чувствительностью, достигающей 5%. Этот подход может быть использован, 

например, для исследования соматических мутаций или изменений в статусе 

метилирования CpG-«островков».  
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Генотипирование SNP 

Являясь представителем минимальных генетических изменений, детекция и 

генотипирование SNP подчеркивает чувствительность HRM-анализа. Неизвестные 

мутации часто являются однонуклеотидными заменами, однако они могут представлять 

собой и изменения сразу в нескольких нуклеотидах, инсерциии и/или делеции. В целом, 

чем больше изменений в ДНК произошло в результате мутации, тем легче ее 

идентифицировать с помощью HRM-анализа. 

SNP разделяются на 4 класса, приведенные в Таблице 3, и наиболее сложным для 

типирования является класс 4 (конверсия A>T). 

Таблица 3. Классы SNP (по определению Verner et al., 2001). 

Класс SNP Нуклеотидная 

замена 

Типичный сдвиг Tm кривой 

плавления 

Частота встречаемости 

(в геноме человека) 

1 C/T или G/A Существенный (>0.5
o
C) 64% 

2 C/A или G/T Существенный (>0.5
o
C) 20% 

3 C/G Существенный (>0.5
o
C) 9% 

4 A/T Очень незначительный (<0.2
o
C) 7% 

 

Советы для успешного HRM-анализа 

Успех HRM-анализа во многом зависит от качества индивидуального продукта 

амплификации и исследуемой специфической последовательности. Все 

экспериментальные параметры должны быть контролируемыми и воспроизводимыми 

между образцами для успешного HRM-анализа. 

Рекомендации для проведения успешного HRM-анализа приведены ниже. 

1. Анализируйте небольшие ампликоны 

Предпочтительным является анализ ампликонов менее 150 п.н., особенно при 

исследовании сайтов неизвестных полиморфизмов. Детекция неизвестных 

полиморфизмов возможна и в более длинных ампликонах, однако однонуклеотидные 

вариации оказывают большее влияние на характеристики плавления 100 п.н. ампликона, 

чем 600 п.н. ампликона. 

2. Анализируйте единственный продукт без примесей 

Избегайте последовательностей, которые с высокой вероятностью будут формировать 

неспецифические продукты или праймер-димеры. Всегда проводите поиск по BLAST 

(http://www.ncbi.nlm.nih.gov/BLAST) для проверки специфичности последовательности 

праймеров. Кроме того, присутствие вторичных структур в одноцепочечных или частично 

денатурированных ДНК может приводить к плохому разрешению и кластерингу. 

Последовательность ампликона должна быть проанализирована с помощью программы 

MFOLD (http://mfold.bioibfo.rpi.edu/cgi-bin/dna-form1.cgi) для уверенности, что она не 

будет формировать вторичные структуры в ходе ПЦР. 

3. Используйте достаточное количество матрицы в ПЦР 

Анализ данных ПЦР в реальном времени может быть исключительно полезным при 

поиске проблем при HRM-анализе. Образцы должны иметь значение порогового цикла 

(CT) менее 30. Продукты, поздно амплифицируемые из-за малого исходного количества 

матрицы или ее деградации, дают нестабильные результаты при HRM-анализе. 

http://www.ncbi.nlm.nih.gov/BLAST
http://mfold.bioibfo.rpi.edu/cgi-bin/dna-form1.cgi
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4. Нормализуйте концентрацию матрицы 

Количество матрицы, используемой в реакции, должно быть постоянным. Нормализуйте 

исходную концентрацию таким образом, чтобы все кривые амплификации были в 

диапазоне 3-ех C(t) друг от друга. 

5. Проведите анализ на присутствие аберрантной амплификации 

Тщательно проанализируйте данные амплификации на присутствие характерной для 

аберрантной амплификации формы кривой. Зубчатая кривая в логарифмическо-линейных 

координатах или кривая, выходящая на меньшее значение плато по сравнению с другими 

реакциями, может указывать на плохую амплификацию или слишком низкий сигнал 

флуоресценции для проведения анализа. Неудачная амплификация может быть вызвана 

присутствием ингибиторов реакции, малым количеством красителя или неправильной 

постановкой реакции. HRM-анализ для таких образцов может приводить к низкому 

разрешению и плохому кластерингу. 

6. Используйте одинаковые концентрации пост-амплификационных образцов 

Минимизация вариаций между реакциями является критическим параметром, и 

использование одинаковой процедуры подготовки образцов минимизирует эту 

вариабельность. Поскольку концентрация фрагмента ДНК влияет на его температуру 

плавления, удостоверьтесь, что каждая реакция достигла плато амплификации. В 

непригодных для анализа реакциях плато может быть не достигнуто при том же 

количестве амплифицированного фрагмента из-за вариабельности в постанове реакций. 

7. Обеспечьте однородность образцов 

Образцы должны быть одинакового объема и с одинаковой концентрацией красителя. 

Характер плавления ДНК зависит от концентрации солей, поэтому концентрация Mg
2+

 и 

других солей должна быть максимально близкой в различных образцах. 

8. Обеспечьте достаточное количество данных в областях до и после Tm. 

Для облегчения интерпретации данных и получения результатов с высокой 

повторяемостью необходимо обеспечить сбор достаточного количества данных в 

стационарных фазах. Это легко достигается сбором данных для HRM-анализа в окне 10
o
C 

или более, центр которого находится в точке наблюдаемой температуры плавления Tm 

амплифицируемого фрагмента. 

 

Совместимость красителей 

Интеркаляционные красители третьего поколения, такие как EvaGreen, LCGreen и SYTO9, 

успешно используются для анализа плавления с высоким разрешением. Эти красители 

малотоксичны и могут использоваться в более высоких концентрациях в реакциях ПЦР в 

реальном времени. Использование этих красителей в более высоких концентрациях 

позволяет достичь более полного насыщения ими двухцепочечной ДНК и уменьшить 

динамическое перераспределение красителя в неденатурированные области ДНК при ее 

плавлении. Использование красителей третьего поколения также позволяет достичь более 

высокой чувствительности и разрешения в профиле плавления благодаря их высокому 

качеству. 

ВНИМАНИЕ! SsoFast EvaGreen supermix не может быть использована для бисульфитно-

конвертированной ДНК для анализа метилирования. 

  



HRM-анализ 

4 

HRM-анализ в литературе 

Для более полной информации о HRM-анализе смотри в следующие ссылки. 

Основы технологии 

 Wittwer CT, Reed GH, Gundry CN, Vandersteen JG, Pryor RJ. (2003) High resolution 

genotyping by amplicon melting analysis using LCGreen. Clin Chem. 49(6):853-60. 

 Liew M, Pryor R, Palais R, Meadows C, Erali M, Lyon E, Wittwer C. (2004) Genotyping 

of single-nucleotide polymorphisms by high-resolution melting of small amplicons. Clin 

Chem. 50(7):1156-64. 

Современные методы 

 Seipp MT, Durtschi JD, Liew MA, Williams J, Damjanovich K, Pont-Kingdon G, Lyon 

E, Voelkerding KV, Wittwer CT. (2007) Unlabeled oligonucleotides as internal 

temperature controls for genotyping by amplicon melting. J Mol Diagn. 9(3):284-9. 

 Dames S, Margraf RL, Pattison DC, Wittwer CT, Voelkerding KV. (2007) 
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Глава 2. Программное обеспечение Precision Melt 

Analysis™ 

 

В этой главе изложена информация по установке программного обеспечения Precision 

Melt Analysis. 

 Совместимость приборов (см. ниже) 

 Компоненты программного обеспечения Precision Melt Analysis (стр. 6) 

 Установка программы (стр. 7) 

 Защитный ключ (стр. 9) 

 Калибровка плавления (стр. 9) 

 

Совместимость приборов 

Системы для ПЦР в реальном времени CFX96™ и CFX384™ могут использоваться в 

комбинации с программой Precision Melt Analysis для проведения HRM-анализа и 

характеристике образцов на основании длин последовательностей, содержания CG-пар и 

комплементарности ДНК. Программа Precision Melt Analysis может открывать только 

файлы данных, полученные в экспериментах на системах детекции ПЦР в реальном 

времени CFX96 или CFX384 с анализом в программе CFX Manager™. Файлы данных ПЦР 

в реальном времени (.pcrd), получаемые в программе CFX Manager, конвертируются в 

файлы плавления (.melt) при их открытии в программе Precision Melt Analysis. 

ЗАМЕЧАНИЕ: При проведении анализа плавления высокого разрешения с 

использованием систем CFX96 или CFX384 используйте только режим SYBR/FAM only с 

выбором SYBR в качестве флуорофора. 

ПОДСКАЗКА: Для получения оптимальных результатов плавления высокого разрешения 

используйте температурный инкремент 0.2
o
C между шагами (Step) и время задержки 

(Hold time) минимум 10 секунд в протоколе кривой плавления. 

 

Компоненты программного обеспечения Precision Melt Analysis 

Комплект поставки программного обеспечения Precision Melt Analysis включает 

перечисленные ниже компоненты. Если какие-либо из перечисленных ниже компонентов 

отсутствуют или повреждены, свяжитесь с Вашим локальным представителем Bio-Rad. 
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 Компакт-диск с программой Precision Melt Analysis 

 Два защитных (HASP) ключа 

 Руководство пользователя для программного обеспечения Precision Melt Analysis 

 Краткий путеводитель по программе Precision Melt Analysis 

Комплект поставки также включает набор для калибровки плавления (Melt Calibration Kit, 

кат. № 1845020), в который входят: 

 Стандартная ДНК (Melt Calibration DNA standard) 

 Праймера (Melt Calibration Primers) 

 SsoFast EvaGreen supermix 

 Инструкция набора Melt Calibration для программы Precision Melt Analysis. 

 

Установка программного обеспечения 

Программа Precision Melt Analysis предназначена для операционных систем Windows XP 

или Windows Vista. Таблица 4 содержит требования к системе для установки программы 

Precision Melt Analysis. 

Таблица 4. Системные требования для программы Precision Melt Analysis. 

Системные требования Минимальные Рекомендованные 

Операционная система Windows XP Professional SP2 

или выше, Windows Vista 

Home Premium или выше 

Windows XP Professional SP2 

или выше, Windows Vista 

Home Premium или выше 

Привод CD-ROM CD-ROM 

Жесткий диск 10 Gb 20 Gb 

Частота процессора 2.0 GHz 2.0 GHz 

RAM 1 Gb (2 Gb для Windows 

Vista) 

2 Gb 

Монитор 1024 х 768, True color 1280 х 1024, True color 

USB Порт USB 2.0 High-Speed Порт USB 2.0 High-Speed 

Интернет-браузер Internet Explorer Internet Explorer 

Программы  Microsoft Office Suite 

ЗАМЕЧАНИЕ: Программные обеспечения Precision Melt Analysis и CFX Manager 

совместимы и могут быть установлены на одном компьютере. 

Для установки программного обеспечения Precision Melt Analysis: 

1. Программное обеспечение должно быть установлено на компьютер пользователем 

с правами администратора. Удостоверьтесь, что Вы вошли в систему с правами 

администратора. 

2. Вставьте компакт-диск с программным обеспечением Precision Melt Analysis в CD-

ROM. Появится окно установки программы (Рисунок 1). 

ЗАМЕЧАНИЕ: Если экран установки программы не появился, дважды щелкните на 

пиктограмме CD-ROM (CD drive):\Bio-Rad Precision Melt Analysis. Откройте 

файл Readme.txt и следуете инструкциям в нем для установки программы 

вручную. 
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3.  Щелкните Next в окне установки программы (Рисунок 1). 

4. Для установки программного обеспечения Вы должны принять условия 

лицензионного соглашения. Щелкните напротив соответствующего поля для 

принятия условий. Щелкните Next (Рисунок 2).  

5. Щелкните Next для установки программы в указанную папку по умолчанию 

(Рисунок 3).  

  

Рисунок 1. Окно установки программы. 

Рисунок 2. Условия лицензионного соглашения. 

Рисунок 3. Название папки для установки программы. 
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6. Программа готова к началу установки. Щелкните Install для установки программы 

в указанную папку (Рисунок 4). 

7. По завершению установки, щелкните Finish для выхода из программы установки. 

8. После установки на рабочем столе компьютера появится пиктограмма Bio-Rad 

Precision Melt Analysis (Рисунок 5). 

ЗАМЕЧАНИЕ: Для удаления программы Precision Melt Analysis используйте 

функцию Windows Add/Remove Programs. Щелкните Start (Пуск), выберите 

Settings > Control Panel (Панель управления), дважды щелкните Add/Remove 

Programs (Установки и удаление программ или Программы и компоненты) и 

следуйте инструкциям для удаления программы. 

 

Защитный ключ 

Поставляемый защитный (HASP) ключ необходим для использования программы 

Precision Melt Analysis. Необходимо вставить ключ в USB-порт компьютера, прежде чем 

запустить программу. 

ЗАМЕЧАНИЕ: При утере защитного ключа HASP обратитесь к Вашему локальному 

представителю компании Bio-Rad. 

Калибровка плавления 

Прежде, чем программа Precision Melt Analysis сможет проводить анализ данных, 

полученных с помощью систем ПЦР в реальном времени CFX96 или CFX384, необходимо 

провести калибровку плавления. 

ЗАМЕЧАНИЕ: Калибровка плавления необходима вне зависимости от интеркалирующего 

красителя, который будет использоваться в экспериментах, включая SYBR™Green. 

Рисунок 4. Установка программы. 

Рисунок 5. Пиктограмма программы Precision Melt Analysis на рабочем столе. 
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ПОДСКАЗКА: Следуйте инструкциям в Melt Calibration Quick Guide для приготовления 

планшета для калибровки плавления. 

Приготовление планшета для калибровки плавления 

Для приготовления планшета для калибровки плавления в Melt Calibration kit (1845020) 

входят следующие компоненты: 

 10016289. Melt Calibration DNA Standard 

 10016273. Melt Calibration primers 

 1725200. SsoFast™ EvaGreen® supermix 

Необходимые дополнительные материалы 

В дополнение к поставляемым в составе набора компонентам, для проведения калибровки 

необходимы следующие материалы: 

 Пробирки для проведения ПЦР и вода, свободная от нуклеаз 

 MSB-1001. Адгезивная пленка Microseal® ‘B’, оптически прозрачная 

Для калибровки системы CFX384: 

 HSP-3805. Hard-Shell® 384-луночные планшеты (thin-wall, skirted, with clear shell 

and white wells), для использования с системой CFX384 

Для калибровки системы CFX96: 

MLL-9601. Multiplate™ 96-луночные планшеты (low-profile, unskirted, natural wells), для 

калибровки системы CFX96, или 

MLL-9651. Multiplate™ 96-луночные планшеты (low-profile, unskirted, with white wells), 

для использования с системой CFX96 

ВНИМАНИЕ! SsoFast EvaGreen supermix стабильна в течение 12 месяцев при хранении в 

морозильнике с постоянной температурой -20
о
С защищенной от света. Для удобства 

SsoFast EvaGreen supermix может храниться при 2-8
о
С до 6 месяцев. Не рекомендуется 

подвергать повторым замораживанию и оттаиванию. 

Приготовление планшета для калибровки плавления 

1. Добавьте необходимые объемы каждого компонента в пробирку подходящего 

объема (Таблица 5): 

Таблица 5. Приготовление реакционной смеси для калибровки плавления. 

Компонент Объем (ul) для 

системы CFX96 

Объем (ul) для 

системы CFX384 

SsoFast™ EvaGreen® supermix 1200 2250 

Melt Calibration DNA Standard 120 450 

Melt Calibration primers 14.4 27 

Вода для ПЦР 1065.6 1773 

Всего 2400 4500 

2. Закройте крышку пробирки и аккуратно смешайте компоненты реакции на 

вортексе. 
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3. Для того, чтобы собрать содержимое пробирки на ее дне и удалить пузырьки 

воздуха, коротко отцентрифугируйте пробирку. 

4. Добавьте реакционную смесь в каждую лунку реакционного планшета: 

 Для системы CFX96, добавьте 20 ul в каждую лунку 96-луночного планшета. 

 Для системы CFX384, добавьте 10 ul в каждую лунку 384-луночного планшета. 

5. Заклейте планшет адгезивной пленкой Microseal® ‘B’. Отцентрифугируйте 

планшет для сбора компонентов на дне лунок планшета. 

Постановка эксперимента для калибровки плавления 

Эксперимент для калибровки плавления выполняется на системах для ПЦР в реальном 

времени CFX96 или CFX384 с использованием приготовленного планшета для 

калибровки плавления. 

Для генерации файла с данными для калибровки плавления 

1. Включите систему для ПЦР в реальном времени CFX96 или CFX384. 

2. Дважды щелкните на пиктограмму программы CFX Manager на рабочем столе для 

ее запуска. 

3. Выберите Create a new experiment из списка опций в окне Startup Wizard. 

Щелкните ОК для запуска окна Experimental Setup. 

4. В закладке Protocol выберите Create New для открытия редактора протоколов 

Protocol Editor. 

5. Создайте следующий протокол (Таблица 6). 

Таблица 6. Протокол для калибровки плавления. 

Шаг цикла Температура Время Число циклов 

Активация фермента 98
о
С 2 мин. 1 

Денатурация 98
о
С 5 сек. 40 

Отжиг/Синтез 55
о
С 10 сек. 

 95
о
С 1 мин. 1 

 55
о
С 1 мин. 1 

Кривая плавления 70-95
о
С (с инкрементом 

в 0.2
о
С) 

10 сек. / шаг 1 

6. Щелкните ОК для сохранения протокола и возвращения в окно Experimental 

Setup. 

Или, щелкните на вкладке Protocol 

Щелкните Select Existing > Sample Files > Melt Calibration Folder и выберите протокол 

 Melt Calibration Protocol_96 для системы CFX96 

 Melt Calibration Protocol_384 для системы CFX384 

7. Щелкните на вкладке Plate. 

8. Щелкните Select Existing > Sample Files > Melt Calibration Folder и выберите 

название планшета: 
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 Melt Calibration Plate_96 wells_Clear или Melt Calibration Plate_96 wells_White для 

системы CFX96 

 Melt Calibration Plate_384 wells_White для системы CFX384 

9. Щелкните на вкладке Start Run. 

10. Выберите прибор в списке Start Run on Selected Blocks щелчком мыши слева от 

имени прибора. 

11. Щелкнинте Open Lid и загрузите планшет для калибровки плавления в прибор. 

12. Щелкните Close Lid. 

13. Щелкните Start Run для запуска программы. 

14. При запросе сохраните данные калибровки плавления как «Melt 

Calibration_сегодняшняя дата». 

15. Когда программа завершена, файл данных автоматически будет показан 

программой CFX Manager. Удостоверьтесь, что во всех лунках наблюдается схожая 

амплификация и единственный пик плавления (Рисунок 6). 

  

  

Рисунок 6. Данные калибровки плавления. 
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Импорт файла калибровки плавления 

1. Запустите программу Precision Melt Analysis, для чего дважды щелкните на значке 

программы на рабочем столе. 

2. Щелкните Tools > Import Melt Calibration в строке меню (Рисунок 7).  

3. Выберите файл данных, содержащий данные калибровки плавления (расширение 

.pcrd), и щелкните Open. 

4. Появится окно подтверждения успешной калибровки плавления (Рисунок 8).  

5. Щелкните ОК для продолжения и использования программы Precision Melt 

Analysis. 

Рисунок 7. Импорт файла калибровки плавления. 

Рисунок 8. Успешная калибровка плавления. 
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Глава 3. Знакомство с программой Precision Melt 

Analysis 

В этой главе изложена информация, позволяющая начать работать с программой Precision 

Melt Analysis. 

 Главное окно программы (см. ниже) 

 Startup Wizard (стр. 17) 

 Менеджер опций анализа Analysis Options Manager (стр. 17) 

 Файлы программы (стр. 20) 

 Инструменты помощи программы (стр. 20) 

 Подсказки (стр. 20) 

 

Главное окно программы 

Программа Precision Melt Analysis обрабатывает файлы плавления (.melt) автоматически и 

открывает окно анализа данных Data Analysis для их просмотра. Окно имеет несколько 

вкладок, включая графический и табличный виды данных и описание лунок. 

Перед запуском программы Precision Melt Analysis убедитесь, что защитный (HASP) ключ 

вставлен в компьютер, и дважды щелкните по значку программы на рабочем столе. 

Вместо этого можно выбрать Bio-Rad > Precision Melt Analysis в директории All 

Programs (Все программы) меню Windows Start (Пуск). 

Начните работу в главном окне программы со знакомства со следующими возможностями 

(Рисунок 9): 

 Строка меню. Позволяет выбирать команды программы (стр. 15), такие как 

создать или открыть файл 

 Панель инструментов. Щелкните на соответствующей кнопке панели 

инструментов (стр. 16) для открытия файлов, запуска Startup Wizard (стр. 17) или 

окна менеджера опций анализа Analysis Options Manager (стр. 17)  
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 Окно Startup Wizard. Предоставляет доступ к общим командам программы (стр. 

17) 

Строка меню 

Строка меню программы Precision Melt Analysis предоставляет доступ к функциям и 

командам, перечисленным в Таблице 7. 

Таблица 7. Компоненты строки меню главного окна программы. 

Компонент 

меню 

Команда Функция 

File New Melt File Создает новый файл плавления (.melt) из файла 

данный программы CFX Manager (.pcrd) 

New Melt Study Создает новый файл исследования плавления (.mlts) 

Open Melt File Открывает существующий файл плавления (.melt) 

Open Melt Study File Открывает существующий файл исследования 

плавления (.mlts) 

Recent Melt Files Позволяет просмотреть список 10 последних 

открытых файлов плавления и выбрать файл для 

открытия в окне анализа данных Data Analysis 

Exit Выйти из программы 

Tools Analysis Option 

Manager 

Устанавливает параметры анализа 

 Import Melt 

calibration 

Импортирует файл данных калибровки плавления 

(.pcrd), полученный с использованием системы 

CFX96 или CFX384, для создания файла калибровки 

(.mcal) 

Help Contents Открывает раздел помощи программы Help для 

поиска информации о работе с программой и ее 

инструментах 

Index Показывает указатель раздела помощи Help 

Search Поиск по разделу помощи Help 

About Вызывает окно для просмотра информации о версии 

программы 

Рисунок 9. Главное окно программы. 
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Кнопки панели инструментов 

Щелкните на панели инструментов главного окна программы (Таблица 8) для получения 

быстрого доступа к общим командам программы. 

ЗАМЕЧАНИЕ: Для вызова или скрытия панели инструментов выберите View > Toolbar в 

строке меню. 

Таблица 8. Кнопки панели инструментов главного окна программы. 

Кнопка Название Функция 

 

 

 

 

Startup Wizard Открывает окно Startup Wizard для выбора 

общих параметров программы 

 

 

 

 

Create a New Melt file Импортирует файл данных системы CFX96 

или CFX384 (расширение .pcrd) для создания 

нового файла плавления (расширение .melt) 

 

 

 

 

Open a Melt file Открывает окно браузера для выбора 

существующего файла плавления 

(расширение .melt) и его открытия в окне 

анализа данных Data Analysis 

 

 

 

 

Create a New Melt Study Открывает окно анализа плавления Melt 

Study для создания нового анализа 

плавления 

 

 

 

 

Open a Melt Study Открывает окно браузера для выбора 

существующего файла анализа плавления 

(расширение .mlts) и его открытия в окне 

анализа данных Data Analysis 

 

 

 

 

Analysis Options Manager Открывает окно менеджера опций анализа 

Analysis Options Manager  

 

 

 

 

Help Открывает раздел помощи программы Help 

для поиска информации о работе с 

программой и ее инструментах 
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Startup Wizard 

Окно Startup Wizard автоматически появляется при запуске программы Precision Melt 

Analysis (Рисунок 10). Если окно не появилось, щелкните Startup Wizard в панели 

инструментов программы.  

Опции Sturtup Wizard включают следующее: 

 Create a new melt file (Создать новый файл плавления). Создает новый файл 

плавления (.melt), импортируя файл данных (.pcrd), созданный программой CFX 

Manager 

 Open a melt file (Открыть файл плавления). Открывает файл плавления для 

анализа 

 Create a new melt study (Создать новое исследование плавления). Создает 

новый файл исследования плавления для анализа результатов нескольких файлов 

плавления 

 Open a melt study (Открыть исследование плавления). Открывает файл 

исследования плавления (.mlts) для проведения анализа 

 Open the Analysis Options Manager (Открыть Analysis Options Manager). 
Открывает окно менеджера опций анализа Analysis Options Manager для 

просмотра или модификаций параметров анализа 

 

Менеджер опций анализа Analysis Options Manager 

При анализе файлов плавления программа Precision Melt Analysis придерживается 

заданных параметров. Для изменения этих параметров откройте окно менеджера опций 

анализа Analysis Options Manager (Рисунок 11), используя один из следующих способов: 

 Щелкните Analysis Options Manager в панели инструментов программы 

  

Рисунок 10. Окно Startup Wizard. 
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 Выберите Tools > Analysis Options Manager в строке меню главного окна 

программы 

Параметры профиля анализа плавления 

Используйте менеджер опций анализа Analysis Options Manager для выбора параметров 

анализа файла плавления в окне анализа данных Data Analysis. Пользовательские 

параметры анализа могут быть сохранены и применяться для анализа различных файлов 

плавления. Имя текущего профиля параметров анализа показано в выпадающем меню 

Name. На Рисунке 11 показано имя SNP Detection. Отметьте поле Set as default 

(Использовать по умолчанию) для применения этих параметров анализа к новым фалам 

плавления и группам лунок. 

Для создания нового профиля параметров анализа: 

1. Установите параметры анализа, отмечая соответствующие поля или вводя 

желаемые значения в текстовых полях в окне Analysis Options Manager. 

2. Щелкните Add New. 

3. Введите имя в окне запроса. 

4. Щелкните ОК. 

Для переименования профиля параметров анализа: 

1. Выберите имя профиля анализа из выпадающего меню Name. 

2. Щелкните Rename. 

3. Введите новое имя в окне запроса. 

4. Щелкните ОК. 

Для удаления профиля параметров анализа: 

1. Выберите имя профиля анализа из выпадающего меню Name. 

2. Щелкните Delete. 

  

Рисунок 11. Окно Analysis Options Manager. 
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Опции анализа 

Используйте окно менеджера опций анализа Analysis Options Manager для выбора 

параметров для анализируемого файла плавления. 

Auto detect the melt region (Автоматическая детекция области плавления). Выберите 

эту опцию для автоматического выбора программой областей до и после плавления. Для 

идентификации этих областей вручную снимите флажок выбора этой опции и введите 

значения температур в текстовых полях, или используя стрелки вверх-вниз. 

Normalized view (Нормализованный вид). Выберите для открытия файла плавления с 

кривой плавления, показываемой в нормализованном виде во вкладке Precision Melt. 

Temperature shifted view (Вид со сдвигом температуры). Выберите для открытия файла 

плавления с температурным сдвигом, примененным к каждой нормализованной кривой 

флуоресценции по оси температуры (ось х). 

 

Cluster Detection Settings (параметры детекции кластеров) 

Задайте параметры детекции кластеров для определения строгости критерия, 

используемого при кластеринге кривых плавления. 

Melt curve Shape Sensitivity (чувствительность к форме кривой плавления) 

Чувствительность к форме кривой определяет строгость критерия, используемого при 

классификации кривых плавления для их отнесения к различным кластерам. Для 

повышения качества кластеринга увеличьте или уменьшите чувствительность 

кластеринга, основанного на форме кривой плавления. Введите численное значение или 

сдвиньте ползунок вправо или влево. Ввод меньшего процентного значения или 

перемещение ползунка влево уменьшает жесткость отбора и приводит к формированию 

более гетерогенных кластеров. Ввод большего процентного значения или перемещение 

ползунка вправо увеличивает жесткость отбора и приводит к формированию менее 

гетерогенных кластеров. 

При необходимости, вручную уменьшьте чувствительность для исключения большого 

числа ложно-позитивных точек. Высокое значение чувствительности обычно приводит к 

формированию большего числа групп, чем низкое значение. Для большинства 

приложений значение чувствительности к форме кривой при кластеринге, равное 50%, 

дает приемлемые результаты. 

Tm difference Threshold (порог разницы Tm) 

Порог разницы Tm задает наименьшее значение в разнице Tm между образцами, на 

основании которого программа будет относить образцы к различным кластерам. Задайте 

значение в градусах Цельсия, введя число от 0.05 до 1.00. Более низкие значения приводят 

к формированию менее гетерологичных кластеров. 

При необходимости вручную увеличьте порог разницы Tm для исключения большого 

числа ложно-позитивных точек. Для большинства приложений значение порога разницы 

Tm по умолчанию, составляющее 0.15 градусов Цельсия, дает приемлемые результаты. 
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Файлы программы 

Программа Precision Melt Analysis использует для сохранения информации об 

эксперименте специальные форматы файлов (Таблица 9). 

Таблица 9. Типы файлов программы Precision Melt Analysis. 

Тип файла Расширение Как просмотреть и редактировать файл 

Данные .pcrd Просмотр и редактирование в окне анализа 

данных Data Analysis 

Плавление .melt Просмотр и редактирование в окне анализа 

данных Data Analysis 

Калибровка .mcal Не может быть просмотрен 

Исследование 

плавления 

.mlts Просмотр и редактирование в окне исследования 

плавления Melt Study 

 

Инструменты помощи программы 

В разделе помощи Help программы Precision Melt Analysis доступны следующие 

инструменты: 

 Выберите вкладку поиска Search или указателя Index для поиска информации 

 Откройте раздел Glossary для толкования терминов, используемых в программе. 

Для значений широко используемых терминов обратитесь к глоссариям по ПЦР 

 Для многих окон программы, нажмите клавишу F1 на клавиатуре для вызова 

справки по этому окну программы. 

 Любую станицу раздела Help можно вывести на печать, щелкнув правой клавишей 

мыши и выбрав Print (Печать). 

Подсказки 

Подсказки и особенности использования программы Precision Melt Analysis приведены 

ниже: 

 Отрыть файл плавления или файл исследования плавления можно, перетащив его 

из папки в открытое окно программы 

 Информацию многих окон программы можно отправить на печать или 

экспортировать, щелкнув правой кнопкой мыши на графике, таблице или кнопке 

выбора лунки 

 Для изменения размера окна щелкните мышью на его границе и растяните 

 Откройте окно Preferences для задания параметров по умолчанию, которые 

активируются при каждом запуске программы 

 Для добавления файлов плавления в исследование плавления перетащите их из 

папки в открытое окно исследования плавления Melt Study 

 Открывайте несколько файлов плавления и исследования плавления одновременно 

 Щелкните Settings или Tools для доступа к дополнительным функциям 
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 Для просмотра всей информации, относящейся к одной лунке, из редактора 

планшета Plate Editor, дважды щелкните на лунке для открытия окна информации 

Well Info 

 Щелкните правой клавишей мыши на любом графике или таблице для изменения 

их вида или опций анализа данных 

 Выберите группу лунок для просмотра и анализа только этих лунок планшета. 

Выберите каждую группу лунок по имени в выпадающем меню Well Group панели 

инструментов 
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Глава 4. Обзор анализа данных 

 

В этой главе изложена информация об анализе данных программы Precision Melt Analysis. 

 Окно анализа данных Data Analysis (см. ниже) 

 Селектор лунок (стр. 25) 

 Графики (стр. 27) 

 Таблицы (стр. 27) 

 Просмотр групп лунок в окне анализа данных Data Analaysis (стр. 28) 

 Выбор номера шага (стр. 30) 

 Исключение лунок из анализа (стр. 30) 

 

Окно анализа данных Data Analysis 

В ходе анализа данных изменение вида представления данных никогда не изменяет 

данные флуоресценции, полученные для каждой лунки во время реакции. Вы не можете 

удалить эти данные, однако можете исключить их из показа и анализа. 

Используйте один из способов для открытия файла плавления в окне анализа данных Data 

Analaysis: 

 Перетащите файл плавления (расширение .melt) в главное окно программы 

 Выберите File > New > Melt File в главном окне программы для выбора файла 

программы CFX Manager (.pcrd) в окне браузера Windows с его последующей 

конвертацией в файл плавления (.melt) 

 Выберите File > New > Melt File в главном окне программы для выбора файла 

плавления в окне браузера Windows 

 Выберите File > Recent Files для выбора из списка 10 последних открытых файлов 

плавления 

В окне анализа данных Data Analaysis данные представлены в форме графиков и таблиц 

для определенного метода анализа в одной из пяти вкладок (Рисунок 12).  
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Строка меню окна анализа данных  

Строка меню окна Data Analysis включает следующие опции, перечисленные в Таблице 

10. 

Таблица 10. Опции строки меню окна Data Analysis. 

Компонент меню Команда Функция 

File Save Сохраняет файл 

Save As Сохраняет файл под новым именем 

Close Закрывает окно анализа данных 

Settings View/Edit Plate Открывает редактор планшета Plate Editor 

для просмотра или редактирования планшета 

Mouse Highlighting Включает или выключает одновременное 

выделение данных указателем мыши 

ПОДСКАЗКА: Если Mouse Highlighting 

выключено, удерживайте кнопку Ctrl 

клавиатуры для временного включения 

функции выделения 

Tools Reports Открывает отчет (Report) для текущего файла 

данных 

Replace Plate Заменяет текущий файл планшета в анализе 

данных 

 

  

Рисунок 12. Вид вкладки Precision Melt. 
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Панель инструментов окна анализа данных 

Панель инструментов окна анализа данных Data Analysis  позволяет получить быстрый 

доступ к важным функциям анализа данных (Таблица 11). 

Таблица 11. Панель инструментов окна анализа данных. 

Кнопка панели Название Функция 

 

 

 

 

Save Сохраняет текущий файл плавления 

 

 

 

 

Report Открывает окно отчета Report для текущего файла 

плавления 

 

 

 

 

Analysis Options Открывает окно параметров анализа Analysis 

Options для их просмотра и редактирования 

 

 

View/Edit Plate Открывает окно редактора планшета Plate Editor 

для просмотра и редактирования содержания лунок 

 

 

Well Group… Выбор имени группы лунок из выпадающего меню. 

Параметр по умолчанию – All Wells (Все лунки) 

 

 

 

 

Help Открывает помощь программы Help для получения 

более подробной информации об анализе данных  

 

Вкладки окна анализа данных 

Окно анализа данных Data Analysis содержит пять вкладок (Рисунок 13). Каждая вкладка 

содержит данные в виде графиков и таблиц  для определенного метода анализа с 

селектором лунок для выбора данных для просмотра. Окно Data Analysis открывается на 

вкладке Precision Melt. 

Во вкладках показываются данные для кривой плавления из одного эксперимента 

(протокол и файл планшета, выполненные на одном приборе). 

Вкладка Precision Melt. Показывает данные плавления в четырех представлениях: график 

кривых плавления Melt Chart, график кривых различия Difference Curve, селектор лунок 

и таблица данных. Используйте данные этой вкладки для задания условий анализа, 

включая нормализацию и температурный сдвиг 

Вкладка Precision Melt Data. Показывает таблицу данных в различных форматах: 

результаты (Results), графики (Charts), просмотр планшета (Plate View), первичные 

данные RFU (Primary RFU), нормализованные данные RFU (Normalized RFU), данные 

RFU различий (Difference RFU) 

Вкладка Melt Curve. Показывает график кривых плавления, график пиков плавления, 

селектор лунок и таблицу с данными кривой плавления для каждой лунки. Используйте 

данные этой вкладки для определения температуры плавления (Tm) продуктов ПЦР 

Рисунок 13. Вкладки окна Data Analysis программы Precision Melt Analysis. 
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Вкладка Melt Curve Data. Показывает табулированные данные в различных форматах: 

пики плавления (Melt Peaks), планшет (Plate), амплификация (Amplification), RFU и  

-d(RFU)/dT (данные для пика плавления) в виде таблиц. 

Вкладка Run Information. Показывает информацию об эксперименте, включая протокол, 

опционные заметки, опционный идентификатор (ID) и параметры входа пользователя в 

систему (Рисунок 14). Введите или отредактируйте данные идентификатора для 

эксперимента в поле ID. В разделе Other содержится информация о событиях, таких как 

сообщения об ошибках, которые могли произойти в ходе эксперимента. 

ПОДСКАЗКА: Щелкните правой кнопкой мыши на любом графике, таблице или 

селекторе лунок для вызова дополнительных опций. 

ПОДСКАЗКА: Щелкните View/Edit Plate чтобы открыть редактор планшетов Plate Editor 

и изменить содержание лунок. 

ЗАМЕЧАНИЕ: Данные, показываемые в различных окнах, связаны между собой. 

Например, выделение лунки путем помещения на нее курсора мыши в селекторе лунок 

приведет к выделению данных, относящихся к этой лунке, во всех остальных вкладках. 

 

Селектор лунок 

Щелкните на лунку в селекторе лунок для показа или скрытия данных в графиках и 

таблицах во всех вкладках окна анализа данных Data Analysis. 

 Для скрытия одной лунки, выделите ее и щелкните на ней. Для включения данных 

этой лунки снова выделите ее и щелкните на ней мышью 

 Для скрытия нескольких лунок, щелкните и выберите мышью, растягивая область 

выбора. Для включения данных этих лунок снова щелкните и выберите их мышью 

Рисунок 14. Вкладка Run Information окна Data Analysis. 
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 Щелкните на верхнем левом угле планшета для скрытия всех лунок. Щелкните 

снова на верхнем левом угле планшета для показа данных 

 Щелкните на начале ряда или колонки для их скрытия. Щелкните еще раз для 

включения показа данных лунок колонки или ряда 

Только лунки с содержанием, введенным в редакторе планшета Plate Editor, могут быть 

выбраны в селекторе лунок. Как показано на Рисунке 15, селектор лунок может 

показывать три типа лунок: 

 Выбранные и загруженные лунки (синий цвет): Данные по этим лункам 

показываются на графиках и в таблицах в окне Data Analysis 

 Не выбранные и загруженные лунки (светло-серый цвет): Данные по этим лункам 

не показываются на графиках и в таблицах в окне Data Analysis 

 Пустые лунки (темно-серый цвет): эти лунки на описаны в редакторе планшета 

Plate Editor 

 Пункты меню селектора лунок при его вызове правой кнопкой мыши 

Щелкните правой кнопкой мыши в любом месте изображения селектора лунок для выбора 

опций, приведенных в Таблице 12. 

Таблица 12. Пункты меню селектора лунок при его вызове правой кнопкой мыши. 

Пункт меню Функция 

Copy Копирует содержание лунки в буфер обмена, включая тип образца 

(Sample Type) и опционный параметр Replicate # (№ реплики) 

Copy as Image Копирует изображение селектора лунок как изображение 

Print… Вывод на печать изображения селектора лунок 

Export to Excel… Экспортирует данные планшета в таблицу Excel 

Export to Text… Экспортирует данные планшета как текстовый файл 

Export to XML… Экспортирует данные планшета как файл XML 

 

Рисунок 15. В селекторе лунок могут присутствовать лунки различного цвета. 
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Графики 

Каждый график в окне Data Analysis показывает данные в различной форме и включает 

опции коррекции данных. Для увеличения области графика выберите область, щелкнув и 

растянув ее мышью. Программа изменит размер графика и сцентрирует его вид на 

выбранной области. 

ПОДСКАЗКА: Для возврата к просмотру всего графика щелкните правой кнопкой мыши 

на графике и выберите Set Scale to Default из появившегося меню. 

Пункты меню для графиков, вызываемых правой кнопкой мыши 

Меню, вызываемое щелчком правой кнопки мыши, доступно для всех графиков. 

Некоторые из пунктов меню доступны для всех графиков и могут использоваться для 

изменения представления данных или простого экспорта данных графика (Таблица 13). 

Таблица 13. Пункты меню для графиков, вызываемых правой кнопкой мыши. 

Пункт меню Функция 

Copy Копирует график в буфер обмена 

Copy Image As…  Сохраняет изображение графика в выбранном формате. Выберите 

между форматами PNG (по умолчанию), GIF, JPG, TIF или BMP  

Page Setup… Просмотр и выбор параметров страницы перед печатью 

Print… Вывод на печать изображения графика 

Show Point Values Показывает значения для точек при наведении на них курсором 

мыши 

Set Scale to Default Возвращает к виду графика по умолчанию после увеличения 

Chart Options… Открывает окно опций графика Chart Options для внесения 

изменений в график, включая название графика, выбор лимитов по 

осям x и y, показ сетки и дополнительных делений на осях 

 

Таблицы 

Таблицы, показываемые в окне Data Analysis, включают опции для сортировки и 

переноса данных в другие программы. Для сортировки колонок используется один из 

следующих методов: 

 Щелкните и перетащите колонку на новое место в выбранной таблице 

 Щелкните на заголовке колонки для сортировки данных по нисходящей или по 

восходящей 

Для сортировки до трех колонок данных в окне Sort выполните следующее: 

1. Щелкните на таблице правой кнопкой мыши для вызова меню и выберите Sort. 

2. В окне Sort выберите название первой колонки для сортировки. Отсортируйте 

данные по восходящей (Ascending) или по нисходящей (Desсending) 

3. Выберите название более чем одной колонки посредством выбора названий 

колонок в выпадающем меню. Выберите Ascending или Desending для сортировки 

данных по восходящей или по нисходящей 

4. Щелкните ОК для сортировки данных или выберите Cancel для отмены. 
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Для выделения данных в таблице и селекторе лунок удерживайте курсор мыши на ячейке 

таблицы. При щелчке на ячейке возможно копирование ее содержимого, используя 

CTRL-C, с последующей вставкой в другой программе, используя CTRL-V. 

Пункты меню для таблиц, вызываемых правой кнопкой мыши 

Щелкните правой кнопкой мыши на любом месте таблицы для выбора пунктов меню, 

показанных в Таблице 14. 

Таблица 14. Пункты меню для таблиц, вызываемые правой кнопкой мыши. 

Пункт меню Функция 

Copy Копирует содержание выбранных лунок в буфер обмена, которое 

может быть вставлено в таблицы других форматов, например, Excel 

Copy as Image Копирует таблицу как изображение которое может быть вставлено в 

файлы, допускающие графическую информацию, например, в текст, 

изображение или таблицу 

Print… Выводит на печать текущий вид 

Print Selection… Выводит на печать выбранные ячейки 

Export to Excel… Экспортирует данные в таблицу Excel 

Export to Text… Экспортирует данные в текстовый редактор 

Export to XML… Экспортирует данные как файл XML 

Export to Html… Экспортирует данные как файл Html 

Find… Текстовый поиск по таблице 

Sort… Сортировка данных (до трех колонок) 

 

Просмотр групп лунок в окне анализа данных Data Analaysis 

Лунки планшета могут быть сгруппированы для индивидуального анализа групп лунок. 

Когда создаются группы лунок в окне менеджера групп лунок Well Groups Manager, 

названия групп появляются в окне Data Analysis в списке групп лунок Well Groups в 

панели инструментов. 

ПОДСКАЗКА: Для вызова редактора лунок Plate Editor, щелкните View/Edit Plate в 

панели инструментов окна Data Analysis. 

По умолчанию при открытии окна Data Analysis выбрана группа лунок All Wells (все 

лунки) с показом данных для всех лунок на графиках и в таблицах. 

На Рисунке 16 показан выбор группы Group 1 в меню Well Groups. Только лунки из этой 

группы показываются в селекторе лунок, и только данные для этих лунок включаются в 

расчеты при анализе данных. 
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Менеджер групп лунок Well Groups Manager 

Создайте группы лунок в менеджере групп лунок Well Groups Manager для независимого 

анализа наборов лунок на одном планшете в окне Data Analysis. Например, создайте 

группы для анализа нескольких экспериментов, поставленных на одном планшете. Также 

можно провести анализ одних и тех же лунок с различными параметрами анализа. 

Для вызова менеджера групп лунок откройте редактор планшета Plate Editor и щелкните 

Well Groups на панели инструментов (Рисунок 17). 

Рисунок 16. Окно Data Analysis при выборе группы лунок Group 1. 

Рисунок 17. Окно Well Groups Manager. 



Обзор анализа данных 

30 

Для создания групп лунок в Well Groups Manager следуйте этим инструкциям: 

1. Щелкните Add для создания новой группы. В выпадающем меню показано имя 

группы как Group 1 для первой группы. 

2. Выберите лунки, которые составят группу, на изображении планшета. Лунки, 

входящие в группу, показаны синим цветом, а лунки, не входящие в группу – 

светло-серым. Для добавления лунок щелкните на лунке, которую необходимо 

добавить. Для удаления лунки из группы еще раз щелкните на ней. Для добавления 

или удаления группы лунок щелкните и выделите мышью группу лунок. 

3. Создайте остальные группы, повторяя шаги 1 и 2. 

4. Для просмотра групп лунок выберите ее имя из выпадающего списка. 

5. (Опция) Для изменения имени группы выберите имя группы в выпадающем списке 

и введите новое имя. 

6. (Опция) Для удаления группы выберите имя группы в выпадающем списке и 

щелкните Delete. 

7. Щелкните ОК для завершения и закрытия окна, или щелкните Cancel для закрытия 

окна без внесения изменений. 

8. После создания групп их список в окне Data Analysis содержится в выпадающем 

меню Well Group. 

 

Выбор номера шага 

Системы CFX96 и CFX384 могут получать данные флуоресценции на нескольких шагах 

протокола. Программное обеспечение запоминает данные, полученные на каждом шаге, 

независимо друг от друга. Программа Precision Melt Analysis показывает селектор Step 

Number под графиком Difference Curve во вкладке Precision Melt, если протокол 

содержит более одного шага сбора данных кривой плавления. При выборе шага этот 

параметр применяется ко всем данным, показываемым в окне Data Analysis. На Рисунке 

18 показано, что номер шага сбора данных 7. 

 

Исключение лунок из анализа 

Используйте одну из нескольких опций для временного исключения лунок из анализа. 

Исключение единичной лунки из анализа с помощью щелчка правой клавишей 

мыши. 

1. Щелкните правой клавишей мыши в селекторе лунок, на кривой флуоресценции на 

любом графике или на данных лунки в таблице. 

2. Выберите Exclude Well B7 from Analysis в опциях меню (Рисунок 19). 

3. Исключенные лунки окрашены в темно-серый цвет в селекторе лунок с 

содержанием лунки, остающимся в ней. 

Рисунок 18. Выбор номера шага Step Number в окне Data Analysis. 



Руководство пользователя программного обеспечения Precision Melt Analysis 

31 

4. Отмените выбор опции Exclude Well from Analysis в меню, вызываемом щелчком 

правой клавиши мыши, для возврата лунки в анализ. 

Опция редактора планшета Plate Editor для исключения нескольких лунок. 

1. Выберите View/Edit Plate в панели инструментов окна Data Analysis. 

2. Выберите одну или несколько лунок в селекторе лунок. 

3. Щелкните Exclude Wells in Analysis (Рисунок 20) для исключения выбранных 

лунок. Это поле находится под управляющими кнопками редактора планшета в 

правой части окна. 

 

  

Рисунок 19. Исключение лунки из анализа с помощью щелчка правой клавишей мыши. 

Рисунок 20. Поле Exclude Wells in Analysis. 
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На Рисунке 21 несколько лунок исключены из анализа в редакторе планшета Plate Editor. 

Исключенные лунки отмечены звездочкой (*) и окрашены в серый цвет. 

В качестве альтернативы, для перманентного исключения лунок из анализа очистите 

содержание лунок в редакторе планшета Plate Editor, щелкнув Clear Wells. 

ВНИМАНИЕ! Вам придется вновь вводить содержание лунок, которые были очищены.

Рисунок 21. Исключенные лунки (помечены *) в редакторе планшета Plate Editor. 
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Глава 5. Анализ данных плавления 

В этой главе изложена информация по анализу данных плавления в программе Precision 

Melt Analysis. 

Обработка данных плавления (см. ниже) 

Вкладка Precision Melt (стр. 34) 

Вкладка Precision Melt Data (стр. 42) 

Вкладка Melt Curve (стр. 47) 

Вкладка Melt Curve Data (стр. 49) 

 

Обработка данных плавления 

Программы Precision Melt Analysis строит график зависимости относительной 

флуоресценции (RFU), полученной во время плавления, от температуры. Программа 

автоматически начинает с первичных данных кривой плавления и далее выполняет 

следующие действия: 

 Детекция негативных лунок. Все лунки с обозначением типа образца NTC или 

Negative Control (негативный контроль) в редакторе планшета автоматически 

считаются негативными. Любая лунка с низким начальным RFU также считается 

негативной. Все лунки, считающиеся негативными, автоматически исключаются из 

анализа 

ЗАМЕЧАНИЕ: Автоматически присвоенный негативный статус лунок может быть 

изменен путем включения или исключения лунок из анализа кластеров. Это может 

быть сделано щелчком правой клавишей мыши на данных лунки на любом графике 

или через выпадающее меню для лунки в таблице данных 

ПОДСКАЗКА: Процедура может быть проведена для нескольких лунок сразу, для 

чего, удерживая клавишу мыши, выберите лунки 

 Нормализация RFU. Все ненегативные лунки нормализуются по оси RFU (ось y) 

таким образом, что средняя флуоресценция в области до плавления равна единице, 

а в области после плавления – 0. 

 Кластеризация. Программа Precision Melt Analysis автоматически проводит 

кластеризацию для всех ненегативных лунок 

 Построение кривых различий Difference Curve. Для облегчения визуальной 

идентификации кластеров программа генерирует график кривых различий 

Difference Curve на основании данных. Кривая различий показывает разницу 

между флуоресценцией в лунке и флуоресценцией кривой сравнения. Кривая 

сравнения получается путем усреднения флуоресценции всех кривых в выбранном 

кластере сравнения 
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Вкладка Precision Melt 

Используйте данные вкладки Precision Melt для задания условий анализа, включая 

нормализацию и, если требуется, температурный сдвиг. Во вкладке Precision Melt данные 

выводятся в четырех полях (Рисунок 22): 

 График кривых плавления Melt Curve. Показывает зависимость RFU от 

температуры для каждой лунки. Каждая кривая представляет данные по одному 

флуорофору в одной лунке 

 График кривых различий Difference Curve. Показывает RFU различия 

(Difference RFU), отложенные по оси y, в зависимости от температуры, 

отложенной по оси x 

 Селектор лунок. Позволяет выбрать данные для показа 

 Таблица. В таблице показаны данные для выбранных лунок 

ЗАМЕЧАНИЕ: Если протокол включает более одного шага сбора данных (пиктограмма 

камеры), выберите шаг, для которого будут показаны данные, в меню Step Number под 

графиком кривых различий Difference Curve. 

График кривых плавления Melt Curve 

График кривых плавления Melt Curve показывает значения RFU в зависимости от 

температуры для каждой лунки. График кривых плавления Melt Curve содержит 

несколько опций показа данных. 

  

Рисунок 22. Вид вкладки Precision Melt окна Data Analysis. 
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 Normalized view (Нормализованный вид). Выберите Normalized view под 

графиком для просмотра нормализованных кривых плавления (Рисунок 23). 

Изменения вида показываемых данных не изменяет кластеринг данных. 

 Настройка областей до и после плавления. Две пары настраевыемых 

вертикальных ползунков соответствуют области до (зеленая) и после (красная) 

плавления, как это показано на Рисунке 24. Область между ползунками является 

областью плавления. 

Области до и после области плавления устанавливаются автоматически 

программой Precision Melt Analysis. Настройте области до и после плавления, 

двигая ползунки вправо или влево, для чего наведите курсор на линию и 

передвиньте ее, удерживая нажатой левую клавишу мыши. 

ЗАМЕЧАНИЕ: Изменения температурных областей до и после плавления изменяет 

кластеринг данных. 

 Temperature-shifted view (Вид с температурным сдвигом). Выберите 

Temperature-shifted view для просмотра кривых плавления и кривых различий с 

температурным сдвигом (Рисунок 25). Высота черной линии температурного 

сдвига может быть изменена, для чего переместите ее с помощью мыши вверх или 

вниз на графике RFU. Высота линии температурного сдвига соответствует 

Рисунок 23. Опция Normalized view выбрана на графике Melt Curves. 

Рисунок 24. Области до и после плавления, выбранные на графике Melt Curves. 
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значению по оси Y, при котором все кривые плавления пересекутся. Линия 

показывается только если выбрана опция Temperature-shifted view. Значение 

температурного сдвига по умолчанию задается в окне менеджера опций анализа 

Analysis Options Manager. 

ПОДСКАЗКА: Для увеличения любой области графика Melt Chart выберите 

область, щелкнув и растянув ее мышью. Для возврата к просмотру всего графика 

щелкните правой кнопкой мыши на графике и выберите Set Scale to Default из 

появившегося меню 

График кривых различий Difference Curve 

Для облегчения визуальной идентификации кластеров программа Precision Melt Analysis 

генерирует кривые различия для каждой лунки (Рисунок 26). График Difference Curve 

показывает различия во флуоресценции между лункой и референсной кривой. 

Референсная кривая вычисляется как средняя флуоресценция всех кривых для выбранного 

кластера сравнения. Кластер сравнения (Reference cluster) выбирается в меню Reference 

cluster внизу графика кривых различий. 

  

Рисунок 25. Опция Temperature-shifted view выбрана на графике Melt Curves. 

Рисунок 26. Выбор кластера сравнения. 
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Окно опций анализа Analysis Options 

Выберите Analysis Options из панели инструментов окна Data Analysis. В окне опций 

анализа Analysis Options оптимизируйте результаты кластеринга, увеличивая или 

уменьшая строгость условий, используемых для классификации данных лунок по 

различным кластерам (Рисунок 27). 

Выберите параметры для анализа данных файла плавления в окне Data Analysis. После 

изменения параметров щелкните ОК для возврата в окно Data Analysis и применения 

сделанных изменений. Щелкните Cancel для закрытия окна Analysis Options без 

изменений текущих значений параметров. 

 Auto detect the melt region (Автоматическая детекция области плавления). 
Выберите эту опцию для автоматического выбора программой областей до и после 

плавления. Для настройки этих областей вручную снимите флажок выбора этой 

опции и введите значения температур в текстовых полях или используя стрелки 

вверх-вниз 

 Normalized view (Нормализованный вид). Выберите для открытия просмотра 

данных кривых плавления в нормализованном виде на графике Melt Curve 

 Temperature-shifted view (Вид со сдвигом температуры). Выберите для 

применения температурного сдвига к каждой кривой нормализованной 

флуоресценции по оси температуры (ось х) 

 Temperature shift bar height (Высота линии температурного сдвига). Задайте 

высоту линии температурного сдвига, вводя число между 0 (базисная линия) и 1 

(верх области плавления). Для большинства приложений значение высоты линии 

температурного сдвига по умолчанию, равное 0.20, позволяет получить 

приемлемые результаты с кривыми плавления, кластеризующимися в плотные 

группы 

  

Рисунок 27. Окно менеджера опций анализа Analysis Options. 



Анализ данных плавления 

38 

Параметры детекции кластеров Cluster Detection 

Задайте параметры детекции кластеров для определения строгости условий при 

кластеринге кривых плавления. 

Melt curve Shape Sensitivity (чувствительность к форме кривой плавления) 

Чувствительность к форме кривой определяет строгость критерия, используемого при 

классификации кривых плавления для отнесения к различным кластерам. Для повышения 

качества кластеринга увеличьте или уменьшите чувствительность кластеринга, 

основанного на форме кривой плавления. Введите численное значение или сдвиньте 

ползунок вправо или влево. Ввод меньшего процентного значения или перемещение 

ползунка влево уменьшает жесткость отбора и приводит к формированию более 

гетерогенных кластеров. Ввод большего процентного значения или перемещение 

ползунка вправо увеличивает жесткость отбора и приводит к формированию менее 

гетерогенных кластеров. 

При необходимости вручную уменьшьте чувствительность для исключения большого 

числа ложно-позитивных точек. Высокое значение чувствительности обычно приводит к 

формированию большего числа групп, чем низкое значение. Для большинства 

приложений значение чувствительности к форме кривой при кластеринге, равное 50%, 

дает приемлемые результаты. 

Tm difference Threshold (порог разницы Tm) 

Порог разницы Tm задает наименьшее значение в разнице Tm между образцами, на 

основании которого программа будет относить образцы к различным кластерам. Задайте 

значение в градусах Цельсия, введя число от 0.05 до 1.00. Более низкие значения приводят 

к формированию менее гетерологичных кластеров. 

При необходимости вручную увеличьте порог разницы Tm для исключения большого 

числа ложно-позитивных точек. Для большинства приложений значение порога разницы 

Tm по умолчанию, составляющее 0.15 градусов Цельсия, дает приемлемые результаты. 

Профили параметров анализа 

Щелкните Load from Analysis Options Manager (Загрузить из менеджера опций 

анализа) для выбора ранее сохраненного профиля параметров анализа из окна Load 

Analysis Options. Щелкните ОК для применения параметров анализа. 

Щелкните Save to Analysis Options Manager (Сохранить в менеджере опций анализа) 

для сохранения профиля текущих параметров анализа в менеджере опций анализа. 

Введите имя профиля параметров в текстовой строке в окне Save Analysis Options и 

щелкните ОК. 
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Формирование кластеров вручную 

Щелкните правой клавишей мыши на кривой флуоресценции лунки на графике кривых 

плавления Melt Curve или графике кривых разницы Diffrence Curve для изменения 

ассоциации с кластером или изменения имени кластера (Рисунок 28). 

ЗАМЕЧАНИЕ: Процедура может быть проведена для нескольких лунок сразу, для чего, 

удерживая правую клавишу мыши, выберите лунки, растягивая область выбора. 

Выберите опции из списка в меню выбранных образцов Selected Sample: 

 Выберите кластер из списка имен кластеров для включения в него выбранных 

лунок. 

 Выберите <Create New Cluster> (Создать новый кластер) для включения 

выбранных лунок в новый кластер. Введите имя нового кластера в окне Name и 

щелкните ОК. 

 Если автоматическая сортировка лунок была редактирована ранее, выберите 

<Undo Manual Cluster> (Отменить формирование кластеров вручную) для 

возврата к автоматическому формированию кластеров программой. 

 Выберите <Exclude from Clusters> (Исключить из кластеров) для исключения 

выбранных образцов из анализа кластеров. Исключенные образцы показываются с 

пометкой Excluded в колонке Cluster в таблице данных (Рисунок 29). 

Исключенные образцы не отображаются на графике нормализованных кривых 

плавления и графике кривых различий. На графике ненормализованных кривых 

плавления они отображаются черным цветом. График ненормализованных кривых 

плавления показывается при отмене выбора поля Normalized View. 

 Для включения обратно исключенных образцов выберите их на графике 

ненормализованных кривых плавления с помощью щелчка правой клавишей мыши 

для одного образца или выделением нескольких образцов мышью при ее нажатой 

правой клавише, и щелкните <Include in Clusters> (Включить в кластеры) в 

выпадающем меню. 

  

Рисунок 28. Изменение принадлежности к кластеру образца. 
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Изменение параметров кластеров 

Щелкните правой клавишей мыши на кривой флуоресценции лунки на графике кривых 

плавления Melt Curve или графике кривых разницы Diffrence Curve для изменения 

параметров кластера (Рисунок 30). 

Изменения, сделанные для кластера, применяются ко всем образцам в кластере. Выберите 

из опций меню Selected Cluster: 

 Выберите <Set Cluster Name> (Задать имя кластера) для задания имени кластера. 

Введите имя кластера в текстовой строке окна Rename и щелкните ОК 

 Выберите <Set Cluster Color> (Задать цвет кластера) для изменения цвета 

кривых лунок, относящихся к выбранному кластеру. Выберите новый цвет из 

предлагаемых вариантов в окне Color и щелкните ОК 

 Выберите <Set as the Reference Cluster> (Определить как кластер сравнения) 

для использования выбранного кластера в качестве кластера сравнения при 

построении графика кривых различий Difference Curve 

  

Рисунок 29. Образец, исключенный из кластеров. 

Рисунок 30. Изменение параметров кластеров. 
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Таблица вкладки Precision Melt 

В Таблице 15 суммированы данные, показываемые в таблице в правом нижнем углу 

вкладки Precision Melt. 

Таблица 15. Содержание таблицы вкладки Precision Melt. 

Информация Описание 

Well Положение лунки на планшете 

Content Комбинация типа образца Sample Type и номера реплики Replicate #, 

присвоенных лунке в редакторе планшета Plate Editor  

Sample Имя образца, присвоенное в редакторе планшета Plate Editor 

Cluster Имя кластера, к которому относится эта лунка 

Confidence Индикатор относительной вероятности принадлежности образца кластеру 

ПОДСКАЗКА: Для внесения изменений в категории Content и Sample, откройте 

редакторе планшета Plate Editor, щелкнув на View/Edit Plate. 

Доверительный уровень 

Программа Precision Melt Analaysis определяет вероятностное распределение для каждого 

кластера на основании стандартного отклонения кривых плавления в кластере. Каждому 

образцу приписывается значение вероятности на основании его сходства со средней 

кривой, полученной путем усреднения по всем образцам кластера. Доверительное 

значение является индикатором относительной вероятности того, что образец 

принадлежит этому кластеру. 

Изменение кластеров вручную 

Выберите опции из выпадающего меню ячеек колонки Cluster таблицы вкладки Precision 

Melt для изменения принадлежности к кластеру или свойств кластера (Рисунок 31). 

Опции изменения принадлежности к кластеру включают: 

 Выберите имя из списка имен кластеров для включения выбранных лунок в другой 

кластер 

 Выберите <Create New Cluster> (Создать новый кластер) для включения 

выбранных лунок в новый кластер. Введите имя нового кластера в окне Name и 

щелкните ОК 

Рисунок 31. Изменение кластеров в таблице. 
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 Если автоматическая сортировка лунок была редактирована ранее, выберите 

<Undo Manual Cluster> (Отменить формирование кластеров вручную) для 

возврата к автоматическому формированию кластеров программой 

 Выберите <Exclude from Clusters> (Исключить из кластеров) для исключения 

выбранных образцов из анализа кластеров. Исключенные образцы показываются с 

пометкой Excluded в колонке Cluster в таблице данных. Выберите <Include in 

Clusters> (Включить в кластеры) для включения образца обратно в анализ 

кластеров 

Изменения, сделанные для кластера, применяются ко всем образцам в кластере. Опции 

параметров кластеров включают: 

 Выберите <Set Cluster Name> (Задать имя кластера) для задания имени кластера. 

Введите имя кластера в текстовой строке окна Rename и щелкните ОК 

 Выберите <Set Cluster Color> (Задать цвет кластера) для изменения цвета 

кривых лунок, относящихся к выбранному кластеру. Выберите новый цвет из 

предлагаемых вариантов в окне Color и щелкните ОК 

 Выберите <Set as the Reference Cluster> (Определить как кластер сравнения) 

для использования выбранного кластера в качестве кластера сравнения при 

построении графика кривых различий Difference Curve 

ЗАМЕЧАНИЕ: Вышеописанные изменения могут также быть сделаны на графике. 

 

Вкладка Precision Melt Data 

Во вкладке Precision Melt Data показывается таблица, описывающая данные плавления, 

собранные для каждой лунки. Выберите одну из шести опций для просмотра данных в 

различных форматах. 

 Results (Результаты). Показывает табулированные данные 

 Charts (Графики). Показывает множественные графики на одном листе 

 Plate view (Вид планшета). Показывает данные для каждой лунки в форме 

планшета. 

 Raw RFU (Первичная RFU). Показывает значение RFU в каждой лунке для 

каждой температуры 

 Normalized RFU (Нормализованная RFU). Показывает значение 

нормализованной RFU в каждой лунке для каждой температуры 

 Difference RFU (RFU различия). Показывает значение RFU различия в каждой 

лунке для каждой температуры 

ПОДСКАЗКА: Щелкните на таблице правой клавишей мыши для вызова опций. 

Отсортируйте данные в любой таблице, для чего щелкните правой клавишей мыши 

и выберите опцию Sort. Щелкните View/Edit Plate для вызова редактора планшета 

Plate Editor и измените содержание любой лунки планшета. 
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Таблица результатов Results 

Выберите таблицу результатов Results (Рисунок 32) для просмотра данных по каждой 

лунке планшета. 

Таблица результатов включает информацию, перечисленную в Таблице 16. 

Таблица 16. Содержание таблицы результатов Results. 

Информация Описание 

Well Положение лунки на планшете 

Content Комбинация типа образца Sample Type и номера реплики Replicate #, 

присвоенных лунке в редакторе планшета Plate Editor  

Sample Имя образца, присвоенное в редакторе планшета Plate Editor 

Cluster Имя кластера, к которому относится эта лунка 

Percent 

Confidence 

Значение процентной достоверности как мера качества автоматически 

полученных результатов 

Call Type Автоматический (Automatic) или ручной (Manual). Автоматический 

означает, что программа отнесла эту лунку к определенному кластеру. 

Ручной означает, что кластер для лунки был выбран вручную 

 

  

Рисунок 32. Вкладка Precision Melt Data с выбранной таблицей результатов. 
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Таблица графиков Charts 

Выберите таблицу графиков Charts (Рисунок 33) для просмотра нескольких графиков для 

всех лунок. 

Выберите кривую флуоресценции на графике для показа информации, перечисленной в 

Таблице 17. 

Таблица 17. Информация, показываемая для выделенной кривой флуоресценции. 

Информация Описание 

Well Положение лунки на планшете 

Content Комбинация типа образца Sample Type и номера реплики Replicate #, 

присвоенных лунке в редакторе планшета Plate Editor  

Sample Имя образца, присвоенное в редакторе планшета Plate Editor 

Cluster Имя кластера 

 

  

Рисунок 33. Вкладка Precision Melt Data с выбранной таблицей графиков Charts. 
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Таблица Plate View 

Выберите таблицу планшета Plate View для просмотра данных в виде схемы планшета. На 

Рисунке 34 показан вид таблицы в виде планшета. 

Таблица Plate View содержит информацию, указанную в Таблице 18, включая выбранный 

флуорофор на схеме планшета. 

Таблица 18. Информация, показываемая для выделенной кривой флуоресценции. 

Информация Описание 

Content Комбинация типа образца Sample Type и номера реплики Replicate #, 

присвоенных лунке в редакторе планшета Plate Editor  

Sample Имя образца, присвоенное в редакторе планшета Plate Editor 

Cluster Имя кластера 

Color Цвет кластера 

 

Выберите таблицу Raw RFU для просмотра первичных данных флуоресценции для 

каждой лунки при каждом шаге температуры протокола кривой плавления. Номер лунки 

показан над каждой колонкой, а температура указана слева от каждого ряда (Рисунок 35). 

 

  

Рисунок 34. Таблица планшета во вкладке Precision Melt Data. 

Рисунок 35. Таблица Raw RFU во вкладке Precision Melt Data. 
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Таблица Raw RFU включает информацию, описанную в Таблице 19. 

Таблица 19. Содержание таблицы Raw RFU. 

Информация Описание 

Номер лунки (А2, А3, А4 и т.д.) Данные для лунки, приведенные для всех 

загруженных лунок по их положению 

Temperature Данные для температуры в порядке ее возрастания 

для всех загруженных лунок 

 

Таблица нормализованных RFU Normalized RFU 

Выберите таблицу Normalized RFU для просмотра данных нормализованных 

флуоресценций для каждой лунки. Негативные лунки не отображаются в этой таблице, 

так как их флуоресценции исключаются из вычисления нормализованных значений 

(Рисунок 36).  

Таблица Normalized RFU включает информацию, описанную в Таблице 20. 

Таблица 20. Содержание таблицы Normalized RFU. 

Информация Описание 

Номер лунки (А2, А3, А4 и т.д.) Данные для лунки, приведенные для всех 

загруженных лунок по их положению 

Temperature Данные для температуры в порядке ее возрастания 

для всех загруженных лунок 

 

  

Рисунок 36. Вкладка Precision Melt Data, показывающая данные Normalized RFU. 
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Таблица RFU различий Difference RFU 

Выберите таблицу Difference RFU для просмотра данных по различию флуоресценций 

для каждой лунки. Негативные лунки не отображаются в этой таблице, так как их 

флуоресценции исключаются из вычисления значений различия (Рисунок 37). 

Таблица Difference RFU включает информацию, описанную в Таблице 21. 

Таблица 20. Содержание таблицы Difference RFU. 

Информация Описание 

Номер лунки (А2, А3, А4 и т.д.) Данные для лунки, приведенные для всех 

загруженных лунок по их положению 

Temperature Данные для температуры в порядке ее возрастания 

для всех загруженных лунок 

 

Вкладка Melt Curve 

Во вкладке Melt Curve программа Precision Melt Analaysis показывает график значений 

RFU в зависимости от температуры. Для анализа данных пика плавления, для каждого 

пика устанавливается начальная и конечная температуры. Нижняя граница области пика 

определяется положением пороговой линии плавления. Действительный пик должен 

иметь минимальную высоту, соответствующую расстоянию между пороговым значением 

и высотой наибольшего пика. 

Откройте вкладку Melt Curve (Рисунок 38) для определения температуры плавления (Tm) 

амплифицированных продуктов ПЦР. В этой вкладке данные кривой плавления 

представлены в следующих четырех видах: 

 Melt Curve (Кривая плавления). Просмотр данных ПЦР в реальном времени для 

каждого флуорофора как функция RFU от температуры для каждой лунки 

 Melt Peak (Пик плавления). Просмотр значений производной RFU по 

температуре со знаком минус -d(RFU)/dT 

 Селектор лунок. Выбор лунок для просмотра или скрытия данных 

 Таблица пиков. Просмотр таблицы данных для каждой лунки 

ЗАМЕЧАНИЕ: В этой таблице показано не более двух пиков для каждой кривой. Для 

просмотра большего числа пиков щелкните на вкладке Melt Curve Data (стр. 49). 

  

Рисунок 37. Вкладка Precision Melt Data, показывающая данные Difference RFU. 
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Настройка данных кривых плавления 

Настройте данные кривых плавления одним из следующих способов: 

Щелкните и перетащите линию порогового значения на графике Melt Peak для включения 

или исключения пиков из анализа данных. 

Для изменения цвета кривых на графиках Melt Curve и Melt Peak, щелкните на графике и 

выберите опцию стиля кривых Trace Style из меню. Используйте инструменты окна Trace 

Style для настройки вида кривых с предварительным просмотром результатов внесенных 

изменений в селекторе лунок в нижней части окна 

Выберите число в поле номер шага Step Number под графиком Melt Chart для просмотра 

данных кривых плавления для другого шага протокола 

Выберите лунки в селекторе лунок для просмотра только части данных 

Выберите группу лунок для просмотра и анализа данных только части лунок. Группа 

лунок может быть выбрана по ее имени в выпадающем меню групп лунок Well Group в 

панели инструментов 

Таблица вкладки Melt Curve 

В таблице 22 показаны типы информации, присутствующей в таблице в правом нижнем 

углу вкладки Melt Curve. 

Таблица 22. Содержание таблицы вкладки Melt Curve. 

Информация Описание 

Well Положение лунки на планшете 

Fluor Детектируемый флуорофор 

Content Комбинация типа образца Sample Type и номера реплики Replicate # 

Sample Имя образца, присвоенное в редакторе планшета Plate Editor 

Melt Temp Температура пика плавления для каждой лунки. В этой таблице 

приводятся значения только для двух наибольших пиков 

  

Рисунок 38. Вид вкладки Melt Curve в окне анализа данных Data Analysis. 



Руководство пользователя программного обеспечения Precision Melt Analysis 

49 

Вкладка Melt Curve Data 

Во вкладке Melt Curve Data показаны данные вкладки Melt Curve в нескольких 

таблицах, которые включают все пики плавления для всех кривых. Выберите один из 

четырех способов представления данных кривых плавления в таблицах: 

Melt Peaks (Пики плавления). Список всех данных, включая пики плавления, для 

каждой кривой 

Plate (Планшет). Список данных и содержания лунок в формате планшета 

RFU. Список значений RFU при каждой температуре для каждой лунки 

-d(RFU)/dT. Список отрицательных значений изменений RFU при изменении 

температуры (T). Это производная первого порядка для каждой лунки планшета 

Таблица пиков плавления Melt Peaks 

Выберите таблицу пиков плавления Melt Peaks (Рисунок 39) для просмотра данных для 

кривой плавления. 

Таблица Melt Peaks (Рисунок 39) содержит типы информации, перечисленные в Таблице 

23. 

Таблица 23. Содержание таблицы Melt Peaks. 

Информация Описание 

Well Положение лунки на планшете 

Fluor Детектируемый флуорофор 

Content Тип образца Sample Type из редактора планшета Plate Editor 

Target Мишень для амплификации (ген) 

Sample Имя образца, присвоенное в редакторе планшета Plate Editor 

Melt Temperature Температура плавления для каждого продукта, приводимая как один 

(наибольший) пик в каждом ряду таблицы 

Peak Height Высота пика 

Begin Temperature Температура начала пика 

End Temperature Температура конца пика 

 

  

Рисунок 39. Таблица Melt Peaks вкладки Melt Curve Data. 
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Таблица в формате планшета Plate 

Выберите таблицу Plate (Рисунок 40) для просмотра данных кривых плавления в формате 

планшета. 

ЗАМЕЧАНИЕ: Для настройки пиков, идентифицированных программой, скорректируйте 

пороговую линию на графике пиков плавления Melt Peak во вкладке Melt Peak. 

Таблица Plate содержит типы информации, перечисленные в Таблице 24. 

Таблица 24. Содержание таблицы Plate. 

Информация Описание 

Content Комбинация типа образца Sample Type (обязательно) и номера 

реплики Replicate # (опция) 

Sample Описание образца 

Peak 1 Первый (наибольший) пик плавления 

Peak 2 Второй (меньший) пик плавления 

 

Таблица RFU 

Выберите таблицу RFU (RFU) для просмотра значений флуоресценции для каждой лунки 

в каждом цикле во время плавления (Рисунок 41). 

  

Рисунок 40. Таблица Plate вкладки Melt Curve Data. 

Рисунок 41. Таблица RFU вкладки Melt Curve Data. 
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В таблице 25 перечислены типы данных, показанных в таблице RFU. 

Таблица 25. Содержание таблицы RFU. 

Информация Описание 

Номер лунки (А2, А3, А4 и т.д.) Положение лунки на планшете для всех загруженных 

лунок 

Temperature Значение температуры, показанные для ряда с 

несколькими лунками 

 

Таблица -d(RFU)/dT 

Выберите таблицу -d(RFU)/dT (-d(RFU)/dT) для просмотра данных, показанных на 

Рисунке 42. 

 

 

Отчет для файлов плавления 

В окне отчета Report (Рисунок 43) выводится информация о текущем файле плавления 

окна Data Analysis. Для создания отчета выберите Tools > Reports или щелкните Reports 

в панели инструментов окна анализа данных Data Analysis. 

Окно отчета Report содержит четыре части: 

Меню и панель инструментов. Позволяет выбрать опции форматирования, сохранения и 

печати отчета или шаблона отчета 

Список опций (верхняя левая часть окна). Позволяет выбрать опции данных и 

параметры эксперимента, которые будут показаны в отчете 

Поле опций (нижняя левая часть окна). Позволяет ввести информацию о выбранных 

опциях 

Предварительный просмотр (правая часть окна). Предварительный просмотр 

текущего отчета 

  

Рисунок 42. Таблица -d(RFU)/dT вкладки Melt Curve Data. 
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ПОДСКАЗКА: Шаблон отчета может задавать категории информации для любого отчета, 

если сохранить отчет как шаблон (Template). Выберите Template > Save или Save As для 

сохранения шаблона текущего отчета. 

Создание отчета анализа данных 

Для создания отчета анализа данных в окне Data Analysis сделайте следующее: 

1. Выполните окончательную настройку содержания лунок, выбора лунок, графиков 

и таблиц в окне Data Analysis перед созданием отчета. 

2. Щелкните Report в панели инструментов окна Data Analysis для открытия окна 

отчета Report. 

3. Выберите опции, которые должны быть включены в отчет. Окно отчета 

открывается с выбором опций по умолчанию. Щелкните напротив 

соответствующей опции отчета для настройки включения в отчет всей категории 

или индивидуальных опций в ней. 

ЗАМЕЧАНИЕ: Данные, показываемые в отчете, зависят от текущих настроек во 

вкладках окна Data Analysis. 

4. Щелкните Update Report (Обновить отчет) для обновления предварительного 

просмотра отчета. 

5. Распечатайте или сохраните отчет. Щелкните Print в панели инструментов для 

отправки отчета на печать. 

6. Выберите File > Save для сохранения отчета в формате PDF (файл Adobe Acrobat 

Reader), MHT (документ Microsoft) или MHTML (документ Microsoft) и выберите 

место для сохранения файла отчета. Выберите File > Save As для сохранения 

отчета под новым именем или в другом месте. 

Рисунок 43. Пример окна отчета Report для файла плавления. 
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7. (Опция) Создайте шаблон отчета с выбранными категориями данных. Для 

сохранения текущих параметров отчета как шаблона выберите Template >Save или 

Save As. Это позволяет загружать шаблон отчета при последующем создании 

нового отчета. 

Список опций отчета 

В отчет могут быть включены любые опции категорий, описанных в Таблице 26. 

Поставьте или снимите значок выбора напротив соответствующих полей списка опций 

для определения информации, которая войдет в отчет. 

Таблица 26. Категории отчета анализа данных в списке опций. 

Категория Опции Описание 

Header Название, подзаголовок, логотип отчета 

 Report information Дата эксперимента, имя пользователя, имя файла 

данных и путь к нему, выбранные группы лунок 

 Notes Заметки к отчету 

Experimental Setup  

 Run information Включает дату эксперимента, имя пользователя, 

имя файла данных и путь к нему, выбранные 

группы лунок 

 Protocol Шаги протокола и опций в текстовом виде 

 Plate display Показ информации в каждой лунке в формате 

планшета 

Melt Curve  

 Analysis settings Включение номера шага плавления и значения 

параметра пороговой линии 

 Melt Curve Chart Копия графика кривых плавления 

 Melt Peak Chart Копия графика пиков плавления 

 Data Табулированный список данных для каждой лунки 

 

Поле опций отчета 

Информация, показываемая в поле опций отчета, которое находится внизу слева в окне 

отчета Report, изменяется в зависимости от выбора опций из списка опций отчета. В этом 

поле можно ввести информацию, относящуюся к выбранным опциям, выбрать типы 

информаций для показа в отчете или настроить выбранные опции. Щелкните Update 

Report (Обновить отчет) для обновления отчета в поле предварительного просмотра.
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Глава 6. Анализ исследования плавления Melt Study 

В этой главе представлена информация о проведении анализа исследования плавления 

Melt Study в программе Precision Melt Analysis. 

Окно исследования плавления Melt Study (см. ниже) 

Вкладка Study Setup (стр. 55) 

Вкладка Study Analysis (стр. 56) 

Окно отчета исследования плавления Melt Study (стр. 57) 

 

Окно исследования плавления Melt Study 

Программа Precision Melt Analysis может сравнивать данные кривых плавления из 

различных экспериментов, проведенных на одном и том же приборе, для чего 

используется исследование плавления Melt Study. Создайте исследование плавления Melt 

Study, добавляя данные из одного или нескольких файлов плавления (расширение .melt) в 

окно Melt Study. Программа Precision Melt Analysis сгруппирует данные в единый файл 

исследования плавления (расширение .mlts). 

ЗАМЕЧАНИЕ: Максимальное число образцов, которые могут быть включены в анализ 

исследования плавления, лимитируется оперативной и виртуальной памятью компьютера. 

Окно Melt Study содержит две вкладки. На Рисунке 44 показано окно Melt Study со 

вкладками Study Setup и Analysis Setup. 

 Вкладка Study Setup. Щелкните на этой вкладке для управления экспериментами 

в файле исследования плавления 

ЗАМЕЧАНИЕ: Добавление или удаление файлов плавления в исследование 

плавления Melt Study не изменяет данных в этих файлах 

 Вкладка Study Analysis. Щелкните на этой вкладке для просмотра данных 

комбинированных экспериментов 
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Вкладка Study Setup 

Во вкладке Study Setup (Рисунок 44) показан список всех экспериментов в исследовании 

плавления Melt Study. 

 Добавление экспериментов. Щелкните Add Melt Files для выбора файла из окна 

браузера. Для быстрого добавления эксперимента в исследование плавления 

перетащите файл плавления (расширение .melt) в окно Melt Study 

ЗАМЕЧАНИЕ: При добавлении файла плавления с несколькими группами лунок 

выберите группы лунок для добавления в окне Study Setup. 

 Удаление экспериментов. Выберите один или несколько файлов в списке и 

щелкните Remove Selected Files 

 Добавление заметок. Введите текст в поле Notes для добавления комментариев к 

файлу и анализу в исследовании плавления Melt Study 

Файлы данных во вкладке Study Setup окна Melt Study перечислены с указанием 

информации, перечисленной в Таблице 27. 

Таблица 27. Вкладка Study Setup окна Melt Study. 

Название колонки Описание 

File Name Имя файла плавления (расширение .melt) 

File Folder Директория, в которой хранится файл плавления для каждого 

эксперимента в окне Melt Study 

Date Created Дата получения данных эксперимента 

Well Group Name Имя группы лунок, выбранных при добавлении файла в окно Melt 

Study 

Step Шаг протокола сбора данных  

Samples Количество образцов 

 

  

Рисунок 44. Окно Melt Study. 
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Вкладка Study Analysis 

Во вкладке Study Analysis показаны данные всех экспериментов, которые добавлены в 

исследование плавления. Вкладка Analysis Setup имеет те же свойства, что и вкладка 

Precision Melt Analysis. Например, при выделении образца на графике Melt Study 

выделяются и соответствующие ячейки таблицы под графиком (Рисунок 45). 

 

Таблица данных исследования плавления Melt Study. 

В Таблице 28 описана информация, выводимая в таблице Melt Study. 

Таблица 28. Информация таблицы в окне Study Analysis. 

Информация Описание 

Dataset Данные плавления для одного флуорофора из одного файла 

плавления 

Well Положение лунки на планшете 

Content Комбинация типа образца Sample Type и номера реплики Replicate 

#, заданные в редакторе планшета Plate Editor 

Sample Имя образца, присвоенное в редакторе планшета Plate Editor 

Cluster Имя кластера 

Percent Confidence Индикатор относительной вероятности принадлежности образца 

кластеру 

Call type Автоматически или вручную определенная принадлежность к 

кластеру 

 

  

Рисунок 45. Вкладка Study Analysis окна Melt Study. 
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Окно отчета исследования плавления Melt Study 

Щелкните Report в панели инструментов вкладки Study Analysis для вызова окна отчета 

Melt Study. Выберите информацию, относящуюся к исследованию плавления Melt Study, 

которая будет включена в отчет (Рисунок 46). 

ПОДСКАЗКА: Шаблон отчета может задавать категории информации для любого отчета, 

если сохранить отчет как шаблон (Template). Выберите Template > Save или Save As для 

сохранения шаблона текущего отчета. 

Создание отчета исследования плавления Melt Study 

Для создания отчета сделайте следующее: 

1. Щелкните Report в панели инструментов окна Study Analysis для открытия окна 

отчета Report. 

2. Выберите опции, которые должны быть включены в отчет. Окно отчета 

открывается с выбором опций по умолчанию. Щелкните напротив 

соответствующей опции отчета для настройки включения в отчет всей категории 

или индивидуальных опций в ней. 

ЗАМЕЧАНИЕ: Данные, показываемые в отчете, зависят от текущих настроек во 

вкладках окна Data Analysis. 

3. Щелкните Update Report (Обновить отчет) для обновления предварительного 

просмотра отчета. 

4. Распечатайте или сохраните отчет. Щелкните Print в панели инструментов для 

отправки отчета на печать. 

5. Выберите File > Save для сохранения отчета в формате PDF (файл Adobe Acrobat 

Reader), MHT (документ Microsoft) или MHTML (документ Microsoft) и выберите 

Рисунок 46. Пример окна отчета Report для файла исследования плавления Melt Study. 
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место для сохранения файла отчета. Выберите File > Save As для сохранения 

отчета под новым именем или в другом месте. 

6. (Опция) Создайте шаблон отчета с выбранными категориями данных. Для 

сохранения текущих параметров отчета как шаблона выберите Template >Save или 

Save As. Это позволяет загружать шаблон отчета при последующем создании 

нового отчета. 

Список опций отчета 

В отчет исследования плавления Melt Study могут быть включены любые опции 

категорий, описанных в Таблице 29. Поставьте или снимите значок выбора напротив 

соответствующих полей списка опций для определения информации, которая войдет в 

отчет. 

Таблица 29. Категории отчета анализа данных в списке опций. 

Категория Опции Описание 

Header Название, подзаголовок, логотип отчета 

 Report information Дата эксперимента, имя пользователя, имя файла 

данных и путь к нему, выбранные группы лунок 

 Notes Заметки к отчету 

File List  Имя файла данных и путь к нему, дата создания, 

имя группы лунок, номер шага 

Analysis 

Settings 

 Включает окно до и после плавления, 

нормализованный вид, сфокусированный на 

области плавления, вид при сдвиге температуры, 

высоту линии сдвига температуры, параметр 

чувствительность к форме кривой плавления при 

кластеринге, и параметр пороговой линии 

Melt Curve 

Chart 

 Копия графика кривых плавления  

Difference 

Curve Chart 

 Копия графика кривых разностей 

Data  Табулированный список данных для каждой лунки 

 

Поле опций отчета 

Информация, показываемая в поле опций отчета, которое находится внизу слева в окне 

отчета Report, изменяется в зависимости от выбора опций из списка опций отчета. В этом 

поле можно ввести информацию, относящуюся к выбранным опциям, выбрать типы 

информаций для показа в отчете или настроить выбранные опции. Щелкните Update 

Report (Обновить отчет) для обновления отчета в поле предварительного просмотра. 

 

 


